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1. INTRODUCTION

The CATC TRAFFIC GENERATOR host emulator is an invaluable development and test tool for
Universal Serial Bus designers, serving as a flexible USB host for the development of USB
devices, hubs, and silicon. The Traffic Generator host enables stress/limit testing of USB
designs, and observation of design behavior under faulty bus conditions.

Traffic Generator Features:

• fully programmable stand-alone unit, generates desired USB traffic

• serves as a flexible USB host for the development of USB devices, hubs, and silicon

• easy to use Windows application program (Win 3.1, Win 95, and Win NT), compatible with
CATC’s USB Bus & Protocol Analyzers, helps create desired USB bit patterns

• supports both legal (per USB specifications) and illegal messages

• transmits full-speed (FS), low-speed (LS), and combined (root port) USB message packets

• operates in both single-burst and continuous (repetitive) transmission modes

• one, two, or four unique USB traffic patterns can be individually programmed and selected

• individual bits in a 1,048,576-bit (220) USB traffic buffer can be uniquely specified (87.40ns
of FS, or 699.04ns of LS traffic: more than 87 full USB frames)

• each bit programmable with variable bit widths (50%, 75%, and 100%)

• uses an accurate on-board 48.0 MHz oscillator or an external oscillator

• tested for compliance with the USB specification

• one year warranty and hot-line customer support

Following are some examples of useful bus events supported by CATC’s USB Traffic Generator
tool:

• legal bus conditions (legal messages and timing)

• illegal bus conditions, such as:

• bad PID

• bad CRC5 or CRC16

• bad stuffing bits

• short sync. sequence (less than 7 zeroes)

• short idle time

• short SE0 time

• wrong message sequence

• narrow bits (50% or 75%)

• clock jitter and boundary frequency

• single message response (single-burst mode)

• product failure statistics (continuous mode)
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This document explains how to connect and activate the Traffic Generator tool in a USB system
environment. It also explains how to install and run the CATC Traffic Generator software in your
PC.

1.1 USB Overview

USB is an open industry standard, providing a simple and inexpensive way to connect up to 127
devices to a single computer port. Keyboards, mice, tablets, digitizers, scanners, bar-code
readers, modems, printers, and more can all run at the same time. USB devices plug into any
platform that supports the standard, from notebooks to desktop PCs to workstations.

USB is a dynamically reconfigurable serial bus with an elementary data rate of 12,000,000
bits/second, based on off the shelf, low cost micro-controller technology. Its modular layered
software protocol supports sophisticated device drivers and application programs.

Please refer to the USB Specifications for details on the USB protocol. The USB specifications
are available from the USB Implementers Forum at:

USB IF
M/S JF2-51 Tel: +1/ 503 264 0590
2111 NE 25th Avenue Fax: +1/ 503 693 7975
Hillsboro, OR 97124 Web: http://www.usb.org/

2. CATC TRAFFIC GENERATOR SYSTEM

2.1 General

The CATC USB Traffic Generator tool has two major parts:

• a user programmable stand-alone box, to generate the USB traffic

• a Windows application program, to assist in creating the desired USB messages and
downloading them to the generator box

The CATC Traffic Generator box sends out a pre-determined bit stream on the two USB wires
(D+ and D-) of the USB connector. This bit stream is written by the generator software into non-
volatile Flash memory devices in the generator box. By separately controlling each individual bit
on the D+ and D- lines, the generator can send the raw differential USB data as well as the static
bus conditions J, K, and SE0.

The CATC Traffic Generator box can work as a stand-alone box, or under software control when
attached to the PC parallel port. The generator has several operation modes, selected by
activating the front panel switches or by software control. See section 2.3 for details.

The CATC Traffic Generator software is a PC-based Windows application program that enables
creation of desired USB traffic bit streams for the generator. The program can also display data
files previously recorded by CATC’s USB Bus & Protocol Analyzers. Any packets can be
selected from this file and modified bit by bit. Packets can also be deleted, added, and
copied/pasted.
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Each field in every USB packet can be separately specified: Sync, PID, Frame #, Addr, Endp,
Data, CRC, etc. The length of the idle time between packets can also be defined, and individual
bits in any packet changed.

Once a satisfactory data pattern has been created, it can be downloaded to the Flash memory in
the generator box.

2.2 CATC Traffic Generator System Components

The CATC Traffic Generator package includes the following components:

• the USB Traffic Generator box

• an AC to DC converter (110V or 220V AC to 9V DC @ 500mA), to provide power to the
generator box

• a standard USB cable
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• a male-to-male DB25 (25-pin) cable, to connect the Traffic Generator box to the PC parallel
port

• a binder with

• a diskette containing the Traffic Generator software program

• a warranty card

• this user’s manual

2.3 The USB Traffic Generator Box

The USB Traffic Generator box has several user accessible controls on its front and back panels.

2.3.1 Front Panel Description

USB OUT
 Ext.
CLKSend P0

Single

Cont. SelectPWR P1 P2 P3Send P0

Single

Cont. Select P1 P2 P3

The front panel has one connector, six LEDs, and three switches:

• The four pin A-type USB connector is marked “USB OUT”.

• The red “PWR” LED lights up when the box is powered by an external 9V DC power source.

• The P0, P1, P2, and P3 green LEDs indicate which of the four memory pages is selected.

• The green “Ext. CLK” LED indicates that an external clock source is selected.

• The two-position “Cont./Single” switch selects between the single-burst and continuous
packet transmission modes.

• The “Send” push-button activates the USB packet transmission

• The “Select” push-button selects the active memory partition and the clock source

2.3.2 Back Panel Description

Ext. CLK      IN  OUT Parallel Port   9V DC
Trigger
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The back panel has five connectors:

• The +9V DC @ 500mA input power connector is marked “9V DC”.

• A 25-pin parallel port connector is marked “Parallel Port”.

• A trigger output BNC connector is marked “Trigger OUT”.

• A trigger input BNC connector is marked “Trigger IN”.

• An external oscillator input BNC connector is marked “Ext. CLK”.

2.3.3 Single-Burst Transmission Mode

When the “Cont. / Single” switch on the front panel is set to the single-burst mode, the
momentary “Send” switch activates the single-burst transmission. Each time the switch is
pressed, the generator transmits a single burst of the same data pattern.

2.3.4 Continuous Transmission Mode

When the “Cont. / Single” switch is set to the continuous transmission mode, the generator will
start to continuously transmit the USB packet data when the momentary “Send” switch is
activated. In this mode the generator will stop transmitting when the “Send” button is pressed a
second time.

2.3.5 Memory Partition Selection

The “Select” push button is used to select the active memory partition. Pressing the “Select”
button for less than one second will change the active Flash memory partition. The P0, P1, P2,
and P3 green LEDs on the front panel indicate which of the four memory pages is selected. Each
time the “Select” button is pressed, the next memory page (or set of pages) becomes active.

2.3.6 Clock Source Selection

The “Select” push button is also used to select the clock source. Pressing and holding it for more
than two seconds will change the active clock source from the (default) internal clock to the
external clock; repeating the action will change it back. The green “Ext CLK” LED on the front
panel illuminates when the external clock is selected.

2.3.7 Trigger In

The “Trigger IN” BNC connector allows activation of the Traffic Generator tool electronically,
via external circuitry, to start the transmission of the USB data packets. A TTL level negative-
going pulse on the Trigger IN input has the same effect as physically pushing the “Send” button
on the front panel. The Trigger delay from the trigger falling edge to the start of transmission is
100–150 µs.

2.3.8 Trigger Out

The “Trigger OUT” BNC connector can be used to synchronize external circuitry to the Traffic
Generator system. The “Trigger OUT” signal is a negative going TTL signal. The signal goes low
when the generator starts to transmit, and stays low during the USB packet transmission.
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Note: For Traffic Generator boxes that do not have the negative going pulse annotation on the
back panel (as illustrated in the above diagram), the Trigger Out signal is a positive
going TTL signal.

3. MEMORY ORGANIZATION

The Flash memory devices used on the USB Traffic Generator board are 1,024K bit devices
organized as 128K × 8 bits. The generator circuitry reads the Flash data sequentially, one byte
after another, and transmits the data serially on the USB bus (the D+ and D- wires). Each bit in
the Flash memory corresponds to a bit on the USB bus. Thus, the generator can be programmed
to transmit 1,024K different bits.

The 128K Flash memory bytes are divided into 4 equal segments (“pages”) of 32K bytes each,
organized as follows:

number of partitions selected: : 4 2 1

P3 18000-1FFFF 32K 64K 128K

P2 10000-17FFF 32K

P1 08000-0FFFF 32K 64K

P0 00000-07FFF 32K

The memory can be used as one partition of 128K bytes, as two partitions of 64K bytes, or as
four partitions of 32K bytes each. Different data patterns can be loaded into each partition and
used at the user’s discretion. The active partition is selected from the front panel (see section
2.3.5), or by software.

These bits can be transmitted using three different internal clock frequencies (1.5 MHz, 12 MHz,
48 MHz), or an external oscillator provided by the user.

When the generator circuitry reaches the last defined byte in the packet, it resets and starts
reading the Flash memory from the beginning. Thus the same (up to 1,024K bit) pattern can be
transmitted continuously. This is called Continuous Transmission mode.

Alternatively, in the Single-burst Transmission mode, when the generator circuitry reads the last
byte in the packet, it stops transmitting and awaits further instructions.

If, for example, the page selection is set to P1 (using the “Select” front panel switch), the Traffic
Generator circuitry will read the Flash memory beginning at address 08000h. If the
“Cont./Single” switch is set to Continuous Transmission mode, and the “Send” button pressed,
the generator will start transmitting sequentially from address 08000h, continue until it reaches
the end of the selected packet stream (or address 0FFFFh, whichever comes first), read the next
byte from address 08000h, and so on, repeatedly.
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4. SYSTEM SETUP

Set the CATC USB Traffic Generator Box near the USB system under test.

In the USB system, at a point where generated USB bus traffic is desired, connect the CATC
Traffic Generator tool as follows:

Connect one side of a USB cable to the USB connector “USB OUT” on the front panel of
the USB Traffic Generator box.

Connect the other side of the USB cable to the USB device under test

Note 1: CATC recommends the use of USB cables shorter than 2 meters (6 feet) for all
connections to the Traffic Generator system.

Note 2: To observe the bus traffic, a CATC USB Bus & Protocol Analyzer can be connected
between the Traffic Generator tool and the device under test.

To control the generator from a PC, connect the 25-pin cable between the USB Traffic Generator
“Parallel Port” connector and the PC parallel port.

To generate traffic with clock signals other than those specified by the USB standard, connect an
external oscillator with TTL signal levels to the (50 Ω impedance) BNC connector “Ext. CLK”.
A pull-up resistor (in the range of 150–240 Ω) should be included if driving the signal directly
from TTL. Note that the generator is designed to work with three different clock frequencies:
1.5MHz (used for standard low-speed transmission), 12 MHz (used for standard full-speed
transmission, and for low-speed transmission with non-standard bit widths), and 48 MHz (used
for full-speed transmission with non-standard bit widths). Support of external clock signals is
intended to aid tests relating to clock signal jitter and PLL stability, not widely differing
operating frequencies.

Connect the DC plug of the AC to +9V DC @ 500mA converter to the “9V DC” receptacle on
the USB Traffic Generator back panel.

To activate the generator, plug the AC to DC converter into a 110V or 220V power outlet.

The CATC Traffic Generator hardware is now ready for operation.

5. SOFTWARE INSTALLATION (WIN 3.1, WIN 95, & WIN NT)

5.1 General

To install the CATC Traffic Generator software, run the “install.exe” (“ setup.exe” for Win NT)
application from the CATC Traffic Generator software diskette and follow the instructions on the
screen. Note that on Windows NT systems, it is necessary to log in as administrator.

The installation program copies the following files to the PC’s hard drive.
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to the \USBTGEN directory (or that otherwise specified by the user):

• USBTGEN.EXE executable code of the CATC Traffic Generator program

• USBTGEN.HLP CATC Traffic Generator help file

• DEFAULT.OPT default DISPLAY function settings

• DEMO.GEN sample CATC Traffic Generator data file

• SETADDR.GEN sample CATC Traffic Generator data file

• CFGDESC.GEN sample CATC Traffic Generator data file

• DEVDESC.GEN sample CATC Traffic Generator data file

• USBTRGEN.DLL parallel port interface library (Windows NT only)

to the \WINDOWS\SYSTEM directory (for Win 3.1 & Win 95 systems only):

• CTL3D.DLL Windows 3D Control Library

• CTL3DV2.DLL Windows 3D Control Library

to the \WINNT\SYSTEM32 directory (for Win NT only):

• CTL3D32.DLL Windows 3D Control Library

to the \WINNT\SYSTEM32\DRIVERS directory (for Win NT only):

• USBTRGEN.SYS Parallel port driver

The installation program creates a program group for the Generator application once it has
finished copying all the files. The icon for an Uninstall program is also placed in the program
group. This Uninstall program can be run later, if desired, to remove the Traffic Generator
software from the system.

To run the software, double-click on the Traffic Generator icon in the program group created
during installation. Section 6 describes the software in detail.

Note: The “CTL3D.DLL” and the “CTL3DV2.DLL” 3D control libraries may already be
installed on your system. In this case, there is no need to overwrite the existing files.

The CATC Traffic Generator software is now ready for operation.

5.2 Running The Software

The CATC Traffic Generator software is a Windows application, and can be run under Windows
3.1, Windows 95, and Windows NT. To start the program when using Windows 3.1, from the
Program Manager, select the File | Run option, and then use the Browse button to locate the
USBTGEN.EXE file in the C:\USBTGEN directory (or the directory specified during
installation). Optionally, double click on the CATC Traffic Generator icon created during the
software installation.

The program will start with the main window active.
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6. THE CATC TRAFFIC GENERATOR SOFTWARE

6.1 Getting Started

The CATC Traffic Generator software is a PC-based Windows application program that allows
the operator to create desired traffic bit streams for, set up operation modes for, and control the
generator.

The desired traffic bit pattern can be created from scratch, individually defining each packet, or
files with previously designed bit patterns may be opened and edited.

The program can import and display any data file with actual USB traffic previously recorded by
CATC’s USB Bus & Protocol Analyzers. Any packets from this file can be selected and
modified bit by bit. Packets can also be deleted, added, and copied/pasted.

Each field in every USB packet can be individually specified: Sync, PID, Frame #, Addr, Endp,
Data, CRC, etc. The operator can also define the length of the idle time between packets, and
individually change any bit in any packet.

Once the traffic data pattern has been created, it can be stored as a disk file and/or downloaded to
the Generator’s Flash memory.
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6.2 The Main Display Window

The CATC Traffic Generator’s main display incorporates a set of typical Windows pull-down
menus, described below. Additionally, several of the most frequently used functions can be
activated by specific icons located on the command bar. Finally, several operations can be
invoked by clicking directly on the affected packet fields.

The functionality of each icon and menu item is identified in the left portion of the status bar (at
the bottom of the window) when the pointing device cursor moves over the icon.

The following menus are always present in the CATC Traffic Generator main display window:

• File

• Edit

• Setup

• Generator
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• Search

• Window

• Help

Clicking on any of these menus will expand it, offering various function selections. The
following sections describe in detail the operation of each menu item.

6.3 The Status Bar

The status bar is located at the bottom of the Traffic Generator main display window. The
functionality of each icon and menu item is briefly described in the bar when the pointing device
cursor moves over the icon/item. At other times, the bar is divided into three segments, only one
of which is used in the Traffic Generator: the transmission rate of the current file (low- or full-
speed) is displayed in the center segment.

6.4 The File Menu

The file menu behaves as a standard Windows File menu, allowing the operator to open existing
generator traffic data files from previous sessions, save the data file from the current session,
import data files recorded by CATC USB Bus & Protocol Analyzers, create/edit data file
comments, and print all or selected portions of the selected data file.

The File menu includes the following functions:

6.4.1 New

Create (and open) a new CATC Traffic Generator traffic data file. Activating this menu item
opens up the following dialog box.

The new file may be opened as an empty file, allowing the operator to specify packets one by
one, by clearing the “Generate SOF” check box (or, in low-speed mode, by clearing the
“Generate Keep-Alive” check box). Another option is opening the file with pre-existing start of
frame packets, by marking the “Generate SOF” check box  (or, in low-speed mode, with pre-
existing EOP packets, by marking the “Generate Keep-Alive” check box). In this way, custom
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packets can be added to a set of existing packets. A third option is importing a traffic data file
previously recorded by a CATC USB Bus & Protocol Analyzer.

6.4.2 Open...

Open an existing USB traffic data file.

6.4.3 Close

Close an open USB traffic data file.

6.4.4 Save

Save the current USB traffic data file with its existing file name.

6.4.5 Save As...

Save the current USB traffic data file with a new file name.

6.4.6 Save As Text...

Save all or a selected range of the current USB traffic data file in a text format for further
viewing, analysis, and/or printing. Activating this menu item opens up the following selection
box:

Up to 1,000 packets can be saved at a time. The operator can elect to save SOF packets or
exclude them from the text file. The saved file can be opened with any standard text editor.

Note that unlike the window display, which is quite configurable, text files are always created in
a standardized form. All field values are represented as binary digits (except for data fields,
which are hexadecimal); the most significant bit is located on the right (except for data and CRC
fields, which have their MSBs on the left).
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6.4.7 Edit Comment

Create, view, and/or edit the 50-character comment field associated with each USB traffic data
file.

6.4.8 Printer Setup...

The Printer Setup menu item is a standard Windows function that allows configuring of the
printer (paper size, source, orientation, etc.).

6.4.9 Print...

Print all or a selected range of the current USB traffic data file. Activating this menu item opens
up the following selection box:

The specified traffic information will be printed as currently displayed, in color or grayscale as
supported by the destination printer. Any supplied comment (up to 60 characters in length) will
be printed following the current document name at the top of each page.

6.4.10 Exit

Terminate the CATC Traffic Generator Windows application.

6.5 The Edit Menu

The CATC Traffic Generator software provides several options for editing and modifying the
USB traffic. The Edit menu includes functions to add, delete, modify, and copy packets, plus the
ability to reorder frame numbers. Each of these functions can also be activated by a special icon.
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6.5.1 Add...

When the Add...” menu item is selected, the following dialog box opens, allowing insertion of a
new packet:

When the Add button is selected (after specifying the new packet’s location), the following
dialog box opens, enabling definition of the various fields of the new packet.

Only relevant fields can be modified. Start with the PID Type field: the appropriate fields for the
selected PID type will subsequently become active. For example, for the SETUP packet shown
above, the FRAME # and the DATA field are not activated. If the PID is changed to SOF, the
FRAME # field becomes active. For DATA0 and DATA1 PIDs, the DATA field becomes active.
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6.5.1.1 Data Field Editing

Hexadecimal information in the “DATA” field can be edited directly in the “Add Packet”
window; the display scrolls horizontally as necessary. When the field contains more than eight
bytes, however, it is generally more convenient to invoke the data editor by clicking on the “Edit”
button to the right of the data field display. This brings up a larger window in which it is possible
to create and edit larger strings of hexadecimal data (indeed, it is possible to enter more than
1164 bytes of data—the field size limit—though the error will be reported when the generator
software attempts to construct the specified packet).

6.5.1.2 PID Selection

The PID type field permits selection of one specific type of PID for this packet. Once the PID
type is selected, the appropriate packet fields for the selected PID type become active. It is also
possible to specify a “Free Format” entry; when this choice is made, the user can edit the PID
field as desired (using a valid or invalid value), and make use of the DATA field to specify a bit
string to make up the remainder of the packet.

6.5.1.3 Static Bus Event Selection

The Static Bus Event field enables selection of the Reset, Suspend, and Resume static bus events.

6.5.1.4 Preamble Selection

This section is used to generate low-speed packets on a full-speed branch (an operation that is
only meaningful when sending traffic to a hub). Checking the “Issue Preamble” box will cause a
preamble to be sent, using the indicated Sync and PRE PID values (the PRE PID value cannot be
changed, as this is what defines a preamble). Following the preamble, and the hub setup delay,
the remainder of the packet will be transmitted in low-speed mode. Full-speed mode will resume
at the beginning of the subsequent packet. Note that low-speed packets mixed with full-speed
ones consume memory partition space equivalent to their transmission times (i.e., each low-speed
bit takes up the space of eight full-speed bits).

6.5.1.5 Packet Field Modification

Each individual bit in any active packet field can be modified.

6.5.1.6 USB Defaults

The USB standard defines specific bit sequences for Sync (00000001) and EOP (001), plus a 4-
bit hub setup time following preambles. In order to change these values in a particular packet, it
is first necessary to clear the “Use USB defaults” check box.

6.5.1.7 IDLE Length Control

The CATC Traffic Generator software will normally compute the between-packet IDLE times
necessary to sustain a one millisecond spacing between SOF tokens (between keep-alive strobes
in low-speed traffic). Occasionally, the user may wish to modify the idle times in some non-
standard fashion. This can be accomplished by clearing the “Auto IDLE length compensation”
check box which gives access to the IDLE field of the previous packet.
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In general, IDLE length compensation works as follows... When the software generates an initial
sequence of SOF packets, it does so with IDLE times appropriate to maintain the required
spacing. Whenever a packet is insert into the sequence, its transmission time is subtracted from
the previous packet’s IDLE time. Whenever a packet is deleted from the sequence, its
transmission time is added to the previous packet’s IDLE time. In general, this will work as
expected for the casual creation and deletion of packets; should the user elect to manually specify
IDLE times, however, opportunities abound to create timing sequences that violate the USB
standard. It is also possible to create timing violations with combinations of packet deletion and
frame number reordering. The Traffic Generator software does not attempt to monitor this
activity (which, in fact, may well be a valid component of a testing sequence).

6.5.1.8 Bit Stuffing Control

Bit-stuffing is normally performed as defined by the USB standard, but can also be disabled (for
DATA fields only), by marking the “Disable bit stuffing” check box. When this is done, the
presence of a bit stuffing error (caused by six or more consecutive “one” bits) will be indicated
by the inclusion of an exclamation mark in the data field value displayed in the main display
window. Any subsequent bit stuffing errors in the packet are not marked (as their presence is not
adequately defined), and no such errors are marked in “free format” packets.

6.5.1.9 CRC Calculation

The default operation of the generator software is to automatically compute the correct (5- or 16-
bit) CRC for any packet being constructed. This service can be disabled by clearing the “Auto
calculate CRC” check box, allowing the CRC value to be manually entered. CRC values are not
calculated for “free format” packets (as a CRC field is not defined); the user must insert them
manually if required.

6.5.1.10 Bit Width Modification

The specified width of each individual bit in any active packet field (except for DATA fields) can
independently be set to 100% (the normal, default value), 75%, or 50% width, using the
following dialog box:



CATC CATC Traffic Generator User’s Manual Version 2.1

Page 17

Whether or not such bits are transmitted as so defined, or as normal (100%) width, is further
determined when the file is downloaded to the generator box.

6.5.2 Delete...

When the “Delete...” menu item is selected, the following dialog box opens, allowing deletion of
one or a range of packets.

6.5.3 Modify...

When the “Modify...” menu item is selected, the following dialog box opens, allowing selection
of a specific packet for editing.
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When the packet number selection is confirmed, a dialog box (almost identical to that used by
Add Packet, though initialized to display the current data) opens, enabling modification of the
various fields of the chosen packet.

6.5.4 Copy...

When the “Copy...” menu item is selected, the following dialog box opens, allowing the copying
of one or a range of packets to a position following the indicated packet position.

6.5.5 Reorder Frame Numbers...

Inserting and deleting packets can interfere with the sequential ordering of packet frame number.
When the “Reorder Frame Numbers...” menu item is selected, the following dialog box opens,
allowing selection of an initial frame number. All frame numbers in the current traffic data file
will be renumbered in serial order—beginning with the specified hexadecimal value—and given
standard bit widths (i.e., any narrow bit widths that had been specified in frame number fields
will be eliminated).



CATC CATC Traffic Generator User’s Manual Version 2.1

Page 19

Note: For low speed traffic files, this function is disabled, as its meaning is undefined.

6.6 The Setup Menu

The CATC Traffic Generator software provides many options for viewing CATC’s USB Bus &
Protocol Analyzer and Traffic Generator files, and for editing the various USB packets. The
Setup menu includes Display and Generator Options functions that allow customization of the
generation and display of USB protocol traffic.

6.6.1 Display Options...

The Display Options menu item allows customization of the way that the USB traffic data files
are presented on the screen. The USB Data Display Options dialog box includes control buttons
for the selection of data presentation and screen formatting options, plus the ability to save and
restore custom display option configurations.

Once the desired options are established (by selecting the OK button), they will remain valid
until the Display Options function is used again. The specified changes will be immediately
visible in the displayed file.

6.6.1.1 Field Formats

 The CATC Traffic Generator software supports several different formats in which the USB
traffic data can be displayed. When the ‘Field Formats’ button is selected, the following dialog
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box opens, enabling a choice of viewing mode (either binary or hexadecimal format) for each of
the special message fields (Sync, PID, CRC, etc.). In addition, each field can be viewed with the
most significant bit (MSB) positioned on its left or right side.

 It is possible to revert back to the default setting at any time by selecting the ‘Set to Defaults’
button. After making the desired selections, selecting the OK button will close this dialog box
and return to the Display Options dialog box for additional selections.
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6.6.1.2 Field Colors

The Field Colors button allows customization of the color associated with each field in the
message, using the following dialog box:

Users may choose to experiment with this option to achieve a color combination that is best
suited to a particular graphic system. A brighter color might be appropriate for a specific field
that should stand out in the display (e.g. the Setup PID field). Note that the color of an Invalid
Data (error) field cannot be changed; it is permanently set to red.

6.6.1.3 Load and Save Configuration

The Generator program automatically sets up all display options as specified in the ‘default.opt’
file. Should these settings be changed, they can be saved as a new default options file, or under a
different file name. The latter option permits the loading from disk of a complete set of
previously selected options.
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6.6.2 Generator Options...

The Generator Options menu item allows configuration of the hardware for using the USB
Traffic Generator box.

6.6.2.1 Parallel Port

This group box allows the selection of one of three parallel ports with which to communicate
with the Generator hardware.

6.6.2.2 Memory Partition Setup

The options presented in this group allow division of the Flash memory into one, two, or four
partitions. When it is set to one partition, bit patterns can only be downloaded from one USB
traffic file. Conversely, when it is configured to four partitions, up to four different bit patterns
with various traffic rates can be downloaded.

6.6.2.3 Memory Partition Info

Following selection of the desired partition option, this section is updated to display the number
of frames that can fit in each partition.

Note: The terms “partition” and “page” are not used interchangeably. “Partition” refers to
the number of divisions in Flash memory. “Page” always refers to a 32K byte block of
the Flash memory. Thus when the memory is configured as one partition, it consists of all
four memory pages. This is reflected in the number of LEDs that light on the front panel
upon making this selection.
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6.7 The Generator Menu

6.7.1 Generator Download Configuration

The generator download dialog box allows the selection of all or a selected range of packets to
download to the Flash memory, and the specific memory partition to be loaded. The following
screen view shows a situation in which two generator partitions have been specified:

If the current USB traffic file contains bits that have been defined to have non-standard widths
(via the Bit Width option in the Add or Modify Packet functions), the “Enable non-standard bit
widths” check box will be enabled. A mark in this box will preserve the non-standard widths as
they are loaded into the generator box; clearing the box will load only standard (100% width) bits
into the generator box (though the computer-resident file will not be modified).
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6.7.2 Generator Playback Configuration

The generator playback dialog box enables operation of the generator from the screen. The Start
and Stop buttons perform the same functions as the “Send” button on the generator front panel.

6.7.2.1 Playback Mode

Two options are presented in the Playback Mode group box: Continuous Transmission and
Single-Burst. This option mimics the “Cont/Single” toggle switch on the front panel. The
selection of the continuous transmission option places the hardware in continuous playback
mode. In this mode, the Start and Stop buttons are used to begin and end transmission,
respectively. When the single-burst mode is selected, the Start button will cause the hardware to
play back the downloaded patterns once only. The Stop button does not require pressing in this
case, as transmission will automatically stop when it has reached the end.

6.7.2.2 Partition to Play Back

Depending on how the Flash memory was configured from the Generator Setup screen, available
choices are enabled for selection. After the selection has been made, the corresponding page
LEDs on the front panel will be illuminated.

6.7.2.3 Start/Stop Buttons

When one of these buttons is selected, the options selected on this dialog screen will take effect,
and the front panel settings on the hardware will be overridden. Any subsequent button press on
the front panel will also override the settings made from the software.

6.8 The Search Menu

The CATC Traffic Generator software provides a single function (“Go To Packet”) to navigate
the traffic file; it is afforded its own menu for compatibility with the CATC USB Bus & Protocol
Analyzers.
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6.8.1 Go to Packet...

When the “Go to Packet...” menu item is selected, the following dialog box opens. To move
quickly to a view of a specific packet, enter the packet number and select OK; the display will be
repositioned with the specified packet at the top.

6.9 The Window Menu

The Window menu is a standard Windows function that allows the open windows to be viewed
and arranged in different ways.

6.10 The Help Menu

The Help menu is a standard Windows function that supplies additional information on the
various functions of the Generator program when it is in use.

6.11 The Quick Edit Pop-Up Menu

Clicking on the “Packet #” title of any packet display will bring up the following Quick Edit
menu, allowing for a “short cut” way of initiating Add, Delete, Modify, and Copy operations (by
not having to specify the source packet number).

6.12 The Data Field Pop-Up Menu

Clicking on the “DATA” title of any data field will bring up the following single item menu,
selecting it will compute and display the number of bytes in the associated data field.
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7. HOW TO CONTACT CATC

Type of Service Contact

Call for technical support... US and Canada: +1/ 800 909 2282

Worldwide: +1/ 408 727 6600

Fax your questions... Worldwide: +1/ 408 727 6622

Write a letter... Computer Access Technology Corp.
Customer Support
2403 Walsh Avenue
Santa Clara, CA 95051-1302

Send e-mail... support@catc.com

Visit CATC’s Website... http://www.catc.com/

8. WARRANTY AND LICENSE

Computer Access Technology Corporation (hereafter CATC) warrants this product to be free
from defects in material, content, and workmanship, and agrees to repair or replace any part of
the enclosed unit that proves defective under these terms and conditions. Parts and labor are
warranted for one year from the date of first purchase.

The CATC Traffic Generator software is licensed for use on a single PC. The software may be
copied for backup purposes only.

This warranty covers all defects in material or workmanship. It does not cover accidents, misuse,
neglect, unauthorized product modification, or acts of nature. Except as expressly provided
above, CATC makes no warranties or conditions, express, implied, or statutory, including
without limitation, the implied warranties of merchantability and fitness for a particular purpose.

CATC shall not be liable for damage to other property caused by any defects in this product,
damages based upon inconvenience, loss of use of the product, loss of time or data, commercial
loss, or any other damages, whether special, incidental, consequential, or otherwise, whether
under theory of contract, tort (including negligence), indemnity, product liability, or otherwise. In
no event shall CATC’s liability exceed the total amount paid to CATC for this product.


